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1. Turn Off AutoComplete 

2. Change Text Size Quickly 

3. Jump Back and Forth Between Multiple Pages 

4. Find Text on a Particular Webpage 

5. Load Internet Explorer The Fastest Way Possible! 

6. Open Links In New Windows Quicker In Internet Explorer! 

7. Get Rid Of Home Pages! 

8. Disable Page Transition Animations In Internet Explorer! 
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13. Remove Right-Click Menu Items In Internet Explorer! 
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21. What Version Of Internet Explorer Are You Running! 

22. What Are Cookies In Internet Explorer! 

23. Delete All Your Cookies In Internet Explorer! 

24. Where Is My Webpage Coming From In Internet Explorer! 

25. Clear The Cache Automatically In Internet Explorer! 

26. Clear The History Automatically In Internet Explorer! 

27. Prevent Cookies By Site In Internet Explorer! 

28. Clear Internet History In Internet Explorer! 

29. Change Cookie Preferences In Internet Explorer! 

30. Disable History Modification In Internet Explorer! 

31. Disable AutoComplete For Privacy In Internet Explorer! 

32. Allow Cookies By Site In Internet Explorer!  

33. Clear The Website Cache Manually In Internet Explorer! 

34. My Cookies Are Being Deleted In Internet Explorer! 

35. Try Printing In Landscape Mode In Internet Explorer! 

36. Troubleshooting Bad Webpage Printouts In Internet 

Explorer! 

37. Always Preview Before Printing In Internet Explorer! 

38. Shortcut To Security Properties In Internet Explorer! 

39. Block ActiveX Controls In Internet Explorer!  

40. Always Keep Internet Explorer Up-To-Date! 
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42. Prevent An ActiveX Control From Running In Internet 

Explorer! 

43. Just Show The Frequent Favorites In Internet Explorer!  

44. Modify Favorites With The Explorer Interface! 

45. Delete A Favorite In Internet Explorer! 

46. Print A Favorite Without Visiting the Page!  

47. Create A Favorite Shortcut On Your Desktop!  

48. Quickly Rename A Favorite In Internet Explorer! 

49. Sort Your Favorites In Internet Explorer! 

50. Disable Add-On Toolbars And Buttons In Internet 

Explorer! 

 
Turn Off AutoComplete  
 
Normally, IE6 attempts to automatically type in web addresses after you 
begin typing in a few characters. Depending on your setup, IE6 may also try 
to automatically complete forms and passwords for you as well. While this 
may seem useful at times, in other instances this automatic completion can 
be downright annoying. 
 
To turn this feature off, click the "Tools" menu and select "Internet Options". 
From the multi-tabbed dialog box that follows, select the "Content" tab. Click 
the "AutoComplete" button. An "AutoComplete Settings" dialog box appears. 
Now, check or uncheck the options you would like. For example, to stop IE6 
from automatically entering in web addresses, uncheck the "Web addresses" 
checkbox. 
 
Press "OK" to close this dialog box, then "OK" to close the "Internet Options" 
dialog box.  
Top!
 

Change Text Size Quickly  
All products mentioned are registered trademarks or trademarks of their respective companies. 

Questions or problems regarding this web site should be directed to the Webmaster.
Copyright © 1999-2005 Internet Fixes. All rights reserved.

 
Legal Disclaimer        



Fifty New Internet Explorer 6 Miscellaneous Tips And Tricks! 

If you have a wheel mouse, you can use it to quickly increase or decrease 
the size of text. Just hold down the CONTROL key and scroll the wheel up to 
increase text size. Hold down the CONTROL key and scroll the wheel down to 
decrease text size.  
Top!

Jump Back and Forth Between Multiple Pages  

Stuck inside a webpage and want to exit the site? Or, did you do this and 
realize that you need to re-access the document from which you exited? If 
so, you may find yourself clicking the "Back" or "Forward" buttons multiple 
times. Stop doing this! Click on the pulldown arrow next to the "Back" or 
"Forward" buttons and a list of all previous or subsequent pages will appear. 
Just click on the page that you want to visit. 
 
If you have a hard time clicking on the arrow next to the buttons, just right-
click the "Back" or "Forward" button to bring up the same list of sites.  
Top!
 

Find Text on a Particular Webpage  

You know how to search for web pages on the Internet, right? Just use a 
search engine and enter in your desired text and press the search engine's 
"Search" or "Find" button.  
 
Once you've pulled up a webpage, however, do you know how to search the 
page, and only the current page, for your desired text? Click the "Edit" menu 
and select "Find (on this page)". Enter in the text for which you want to 
search and press "Find Next." 
 
Or, you can press CONTROL-F to pull up the "Find (on this page)" dialog box. 
Top!
 
Load Internet Explorer The Fastest Way Possible! 
 
Edit your link (Short Cut) to start Internet Explorer to have -nohome 
after it. For Example: 
 
"C:\Program Files\Internet Explorer\IEXPLORE.EXE" -nohome 
 
This will load internet explorer very fast because it does not load a 
webpage while it is loading. If you want to go to your homepage after 
it is loaded, just click on the home button. 
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Open Links In New Windows Quicker In Internet Explorer! 

You may know that to open a link on a web page in a new browser window, 
you can just right-click the link and choose "Open in New Window" on the 
pop-up box that appears. There's an easier way to do the same thing. Just 
hold the SHIFT key down while left-clicking the link.  
Top!

Get Rid Of Home Pages!  

Tired of seeing MSN, or another webpage every time you start Internet 
Explorer 6? Get rid of this homepage and start with a nice, blank, clean 
window by clicking the "Tools" menu and selecting "Internet Options." On the 
"Internet Options" multi-tabbed dialog box that follows, make sure the 
"General" tab is selected. Under "Home page," click the "Use Blank" button. 
Press OK to close the dialog box.  
 
Now, every time you start Internet Explorer 6, a blank page should appear 
with "about:blank" in the location bar. 
Top!

Disable Page Transition Animations In Internet Explorer!  

Internet Explorer supports page transition animations. This means that if a 
webmaster chooses to do so, his or her page can show an animation 
whenever the page is loaded or exited. While these animations may be nice 
the first few times you seem them, some people may find them annoying. If 
you fall in this category, there is a simple fix to disable the animations. 
 
Click on the "Tools" menu and choose "Internet Options". On the "Internet 
Options" multi-tabbed dialog box that follows, select the "Advanced" tab. 
Underneath "Browsing", you should see a checkbox labeled "Enable page 
transitions". Uncheck this box and press "OK" to disable these animations. 
Top!

Make A Desktop Shortcut In Internet Explorer! 

Want a shortcut on your desktop to your favorite webpage so you can access 
it quicker (such as Internet Fixes at http://www.internetfixes.com/<grin>)?  
 
Just visit a webpage in Internet Explorer, click the "File" menu, choose 
"Send", and then select "Shortcut to Desktop". 
Top!
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View Source Fails In Internet Explorer! 

Problems running the "View Source" command with Internet Explorer 6? If 
this command fails to open Notepad, one culprit may be too many Temporary 
Internet Files or a corrupt temporary file. I know it doesn't naturally seem 
the two problems are related, but they are. To get this feature back, you 
may need to dump Internet Explorer 6's cache. 
 
Clear the Temporary Internet Files in Internet Explorer by clicking "Tools" 
then "Internet Options". When the "Internet Options" multi-tabbed dialog box 
appears, select the "General" tab. Click the "Delete Files" button. When the 
"Delete Files" dialog box appears, check "Delete All Offline Content" then 
press "OK". 
 
This process may take a few minutes. When done, click "OK" to close the 
dialog box. Now, the "View Source" option should open Notepad. If not, 
restart Internet Explorer, revisit the page you were just on, and try again.  
Top!

Start Internet Explorer In Kiosk Mode!  

You can start Internet Explorer 6 by automatically loading a website and 
running in kiosk mode, filling the entire screen with the site and hiding all 
toolbars and menus. This may be useful in batch files. 
 
To do this from the "Start" menu, choose "Run", then type in the following 
and press "OK". 
 
iexplore -k SITE 
 
Replace SITE with the name of the URL to visit. For example, the following 
would start Internet Explorer 6, running Internet Fixes in full-screen mode. 
 
iexplore -k http://www.internetfixes.com 
 
Or, from a batch file, enter the following: 
 
Start "" "C:\Program Files\Internet Explorer\IEXPLORE.EXE" -k SITE 
 
Replace SITE with the name of the URL to visit. If the above results in a "File 
Not Found" error, replace the second quoted string with the path to Internet 
Explorer on your system.  
Top!

Stop Asking To Change Browsers In Internet Explorer! 
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If you frequently switch between Microsoft Internet Explorer 6, Netscape, 
Mozilla, Opera, and possibly other browsers, you may get tired of Internet 
Explorer always asking you whether or not you would like it to be the default 
browser. To stop this prompt from appearing, from within Internet Explorer 
click the "Tools" menu and select "Internet Options". On the multi-tabbed 
"Internet Options" dialog box that appears, select the "Programs" tab. 
Uncheck "Internet Explorer should check to see whether it is the default 
browser" and press "OK" to close the dialog box.  
Top!

Remove Right-Click Menu Items In Internet Explorer! 

When you right-click on a web page in Microsoft Internet Explorer 6, options 
normally appear such as "Back", "Forward", "View Source", etc. However, 
depending on software you have installed (sometimes unwittingly), other 
options may appear when you open this menu. If you are seeing items in the 
right-click menu that you want to remove, you can try this trick. 
 
(WARNING! This tip involves modifying the Registry. Mistakes can 
cause Windows or applications to stop functioning normally. Use at 
your own risk.) 
 
1. From the "Start" menu, select "Run", then type in "Regedit" and press 
"OK".  
2. In the Registry, navigate to the following section: 
HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\MenuExt.  
3. Now, underneath this key you may find folders representing menu items 
you want to remove. To remove the menu items, just click on the keys and 
choose "Delete". 
 
Note that this tip will only remove menu items installed by software. You 
cannot remove menu items such as "View Source" or "Print" using this tip.  
Top!

Display Script Errors In Internet Explorer! 

If you are developing a webpage that involves lots of scripts, when you pull 
up these pages in Microsoft Internet Explorer 6, it may complain that errors 
are on the page, but the browser may not let you know where the errors 
occur. Remedy this. 
 
1. Open Internet Explorer, choosing "Tools" - "Internet Options". 
2. From the multi-tabbed dialog box that follows, click "Advanced". 
3. Scroll down to "Browsing". 
4. Check "Display a notification about every script error". 
5. Press "OK" to close the dialog box. 
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Be sure to uncheck this box when you go back to normal browsing lest 
numerous dialog boxes interrupt your normal Internet surfing. 
Top!

Quick Launch A Web Page In Internet Explorer! 

On some versions of Windows, you have a QuickLaunch bar next to the area 
of the taskbar that shows the currently running programs. This is useful 
because when programs are here, you can launch them more quickly than by 
navigating through the "Start" menu, hence the name "QuickLaunch". 
 
If you have a webpage or a couple of webpages that you visit often, you can 
place shortcuts to these webpages on the QuickLaunch bar. Just visit a 
webpage, then click and drag the icon on the top-left part of the Internet 
Explorer window to your QuickLaunch bar.  
 
If you don't like the web page's icon in the QuickLaunch bar, just right-click 
on the icon and choose "Properties". On the multi-tabbed dialog box that 
follows, click "Web Document". Then, click the "Change Icon" button. You can 
choose from the various icons provided, or click the "Browse" button and 
search your system for more icons. Most DLL and EXE files contain an icon or 
two, or you can type "%SystemRoot%\system32\SHELL32.dll" (without 
quotes) in the "File name" box for a bunch of icons.  
Top!

See Your Most Visited Websites In Internet Explorer! 

Curious about which websites you visited the most in the last couple of 
weeks? Unless you have disabled your Internet Explorer 6 history function, 
you can do the following: 
 
1. Open up Internet Explorer 6. 
2. Press CONTROL-H to open up the "History" pane. 
3. Click on the "View" pull-down and choose "By Most Visited". 
 
The top site in the list is the most visited website. To see how many times 
you have visited a particular site, right-click on a site and choose 
"Properties".  
Top!

Lost http Prefix In URLs In Internet Explorer! 

After dealing with some viruses and spyware, you may have come across a 
situation in Internet Explorer 6 where the default prefix "http://" is missing. 
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For example, if you type in www.internetfixes.com into Internet Explorer, it 
will never add the "http://" in front, making the correct URL 
http://www.internetfixes.com 
 
If this has happened, copy the text between the --- signs below into a file 
called 'prefix.reg' (use Notepad or your favorite text editor). Note that the 
[HKEY] lines are split in two for viewing on this page. Double-click the file 
from Explorer, and it should solve your problem. Since this is a registry 
editing tip, all standard disclaimers apply. 
 
--- 
[HKEY_LOCAL_MACHINE\Software\Microsoft\ 
Windows\CurrentVersion\URL\DefaultPrefix] 
@="http://" 
 
[HKEY_LOCAL_MACHINE\Software\Microsoft\ 
Windows\CurrentVersion\URL\Prefixes] 
"ftp"="ftp://" 
"gopher"="gopher://" 
"home"="http://" 
"mosaic"="http://" 
"www"="http://" 
---  
Top!

Easter Egg Acknowledgements In Internet Explorer! 

Although it's not quite an Easter Egg in Internet Explorer 6.0, the following 
does provide you with a "Thank You!" screen plus a list of the Internet 
Explorer 6.0 team members: 
 
1. Open up Internet Explorer 6.0 
2. Choose "Help" then "About Internet Explorer". 
3. Click the "Acknowledgements" link in the bottom of the dialog that follows. 
4. Sit back and enjoy!  
Top!

Clicking On A Hyperlink Does Nothing In Internet Explorer!  

Does clicking a link in Internet Explorer 6 do nothing? If you are having 
difficulty running the web browser, part of your operating system or registry 
may have gotten damaged. This could have been due to a virus, spyware, or 
just turning off the computer without going through the "Start" - "Shut 
Down" process. The following Microsoft Knowledge Base article may help: 
 
http://support.microsoft.com/default.aspx?scid=kb;en-us;281679  

All products mentioned are registered trademarks or trademarks of their respective companies. 
Questions or problems regarding this web site should be directed to the Webmaster.

Copyright © 1999-2005 Internet Fixes. All rights reserved.
 

Legal Disclaimer        

http://support.microsoft.com/default.aspx?scid=kb;en-us;281679


Fifty New Internet Explorer 6 Miscellaneous Tips And Tricks! 

Top!

Troubleshoot Internet Explorer Running Slowly!  

Is Internet Explorer 6 all of a sudden running much more slowly than 
normal? Here are a few things you should try: 
 
1. Clear your website cache. If it is too big, Internet Explorer 6 may slow 
down. 
 
2. Scan your computer for viruses with your virus scanner. If you don't have 
one, consider the free AntiVir product. 
 
3. Defrag your hard drive. Double-click "My Computer" on your desktop. 
Right-click your hard drive in Windows Explorer, choose "Properties", select 
"Tools", click "Defragment Now", and follow the on-screen instructions. 
 
4. You may have spyware or adware. Visit the Internet Fixes removing 
spyware and adware page for more information on ridding yourself of these 
pests.  
Top!

What Version Of Internet Explorer Are You Running!  

You should always consider upgrading to the latest version of Internet 
Explorer to ensure you have all available security and stability updates. To 
see which version of Internet Explorer you are running: 
 
1. From Internet Explorer 6 - click "Help" - "About Internet Explorer". 
 
2. Read the version information in the "About Internet Explorer" dialog box. 
If you are running Windows XP and the "Update Versions" does not have at 
least "SP2", you need to update your web browser.  
Top!

What Are Cookies In Internet Explorer!  

"Cookies" are data that web sites send to your computer while running 
Internet Explorer 6. This data can record things such as where you've visited 
in a site, how often you've visited the site, ..etc. It may also contain auto-
login information so if you repeatedly visit a site that asks for your username 
and password, the cookie can take care of entering this information to the 
website automatically. Such cookies may also contain personalization 
information so that if you visit a news site, a cookie may tell the website that 
you like sports news and don't need to see market reports, for example. 
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While some cookies do not associate your actual name with the places you 
visit, if the web site happens to pick up your name, such as with a cookie 
that holds auto-login information, and cross-references the two pieces of 
information, that web site can find out a lot of things about you personally 
that you may not wish the web site's administrators to know. However, this 
may be a small price to pay for personalization features.  
Top!

Delete All Your Cookies In Internet Explorer! 

Using Internet Explorer 6, you can instantly remove all your browser-stored 
cookies. Just click the "Tools" menu and select "Internet Options". From the 
multi-tabbed dialog box that follows, select the "General" tab. Click the 
"Delete Cookies" button underneath "Temporary Internet Files" and press the 
"OK" button to confirm. 
 
Note that deleting all your cookies may delete saved settings on certain web 
sites.  
Top!

Where Is My Webpage Coming From In Internet Explorer! 

Just because you happen to visit a webpage at a given URL does not mean 
that webpage just comes from one address. Banners may be loaded from 
other URLs, integrated content may come from elsewhere, scripts may be 
loaded from other sites, and more.  
 
To see just where your webpage in Internet Explorer 6 is coming from, click 
the "View" menu and choose "Privacy Report". You'll see a list of all the 
webpages and graphics that make up your page, plus the cookies that 
websites tried to set on your machine and whether or not they were accepted 
or blocked, based on your privacy settings. 
 
Click "OK" to close the dialog box when done.  
Top!

Clear The Cache Automatically In Internet Explorer! 

For various reasons, you may want your Internet Explorer cache (the 
Temporary Internet Files folder) to be cleared whenever you exit the 
browser. Perhaps you don't want the folder to get too big; perhaps you want 
to clear your tracks for security or privacy reasons, etc. To do this: 
 
1. Open Internet Explorer, choosing "Tools" - "Internet Options". 
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2. From the multi-tabbed dialog box that follows, click "Advanced". 
3. Scroll down to "Security". 
4. Check "Empty Temporary Internet Files folder when browser is closed". 
5. Press "OK" to close the dialog box. 
 
If you are doing this for security reasons, do realize that deleted files can 
sometimes be recovered by people who know what they're doing.  
Top!

Clear The History Automatically In Internet Explorer! 

Your history file stores the last places you have visited on the web. To make 
sure the file doesn't get too big, Internet Explorer automatically clears the 
history after items have been in for a certain number of days. If you find 
history items being deleted too quickly or if you want to cover your surfing 
tracks by deleting history items faster, do the following. 
 
Click on the "Tools" menu, selecting "Internet Options." On the "Internet 
Options" multi-tabbed dialog box that appears, near the bottom of the dialog 
box, you should see this prompt: 
 
"Days to keep pages in history:" 
 
If you want your history pages to expire after seven days, place a 7 in the 
box and press OK. If you want pages to expire sooner, enter a smaller 
number. If you want pages to expire later, enter a larger number.  
Top!

Prevent Cookies By Site In Internet Explorer! 

Are you concerned about a particular website setting cookies on your 
machine? You can prevent websites, by domain, from setting cookies on your 
machine by doing the following from within Internet Explorer 6. 
 
1. Choose "Tools" - "Internet Options". 
2. From the "Internet Options" multi-tabbed dialog box that appears, select 
the "Privacy" tab. 
3. Click the "Edit" button next to "To Over ride cookie handling for individual 
web sites" 
4. Type in a domain and press the "Block" button to prevent that domain 
from setting cookies on your machine. 
5. Press "OK" and close both dialog boxes when done.  
Top!

Clear Internet History In Internet Explorer! 
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Normally, Internet Explorer 6 keeps track of the websites you visited during 
the last few days in a History list, accessible by pressing CONTROL-H. While 
this may be useful in that you can more easily remember and access recently 
visited websites, if several people access your machine, others might also be 
able to view your recently visited sites. Thus, for privacy, if you want to 
temporarily clear the History list, do the following: 
 
1. From Internet Explorer, choose "Tools" then "Internet Options". 
2. When the "Internet Options" multi-tabbed dialog box appears, select the 
"General" tab. 
3. Click the "Clear History" button. 
4. Press "OK" to close the dialog box. 
Top!

Change Cookie Preferences In Internet Explorer! 

You can change cookie preferences for the Internet zone based on your 
privacy and Internet usage needs, either allowing all sites to set cookies, 
disallowing all cookies, or allowing cookies to be set based on certain 
circumstances. 
 
To set the cookie preferences: 
 
1. From Internet Explorer, choose "Tools" then "Internet Options". 
 
2. From the "Internet Options" multi-tabbed dialog box that appears, select 
the "Privacy" tab. 
 
3. From here, you can raise or lower the slider to heighten or lessen the 
cookie blocking settings. To the right of the slider is a description of what 
each setting does regarding cookies. Note that if you block all cookies, 
certain websites may not function correctly. 
 
4. Click "OK" when done. 
Top!

Disable History Modification In Internet Explorer! 

There may be times where you need to disable the ability for a user on your 
machine to modify their history settings. The following registry edit will do 
just that for the current user, graying out their history settings. Note that as 
this is a registry edit, standard disclaimers apply. 
 
1. Open REGEDIT. 
2. Navigate to section: HKEY_CURRENT_USER\ Software\ Policies\ Microsoft\ 
Internet Explorer\ Control Panel. 

All products mentioned are registered trademarks or trademarks of their respective companies. 
Questions or problems regarding this web site should be directed to the Webmaster.

Copyright © 1999-2005 Internet Fixes. All rights reserved.
 

Legal Disclaimer        



Fifty New Internet Explorer 6 Miscellaneous Tips And Tricks! 

3. Create a new DWORD value. 
4. Name it "History". Give it a value of "1". 
5. Close REGEDIT. 
 
Close and re-open Internet Explorer. If you access the "Internet Options", 
you'll note that the "History" section is grayed out.  
Top!

Disable AutoComplete For Privacy In Internet Explorer! 

Normally, Internet Explorer 6 comes enabled with a feature called 
AutoComplete. This enables Internet Explorer to automatically fill in a web 
address or a username/password combination in a form when it recognizes 
such information based on your typing of a partial entry. This may be useful 
in that it can save you typing, especially if you frequently visit the same site 
or reenter the same information in forms. However, if someone else uses 
your machine with the same account, they may be able to see which 
websites you visit or get access to your username and password information. 
 
To disable all AutoComplete settings: 
 
1. From Internet Explorer, choose "Tools" then "Internet Options". 
2. From the "Internet Options" multi-tabbed dialog box that appears, select 
the "Content" tab. 
3. Click the "AutoComplete" button. 
4. Uncheck everything. 
5. Click the "Clear Forms" button. 
6. Click the "Clear Passwords" button. 
7. Press "OK" to close the dialog boxes. 
Top!

Allow Cookies By Site In Internet Explorer!  

If you have Internet Explorer 6 set to reject all cookies due to privacy 
concerns, you may find it necessary for a certain site or two to be able to set 
cookies. This may be useful for logins or personalization. To enable a specific 
site to set cookies on your machine: 
 
1. From Internet Explorer, choose "Tools" then "Internet Options". 
2. From the "Internet Options" multi-tabbed dialog box that appears, select 
the "Privacy" tab. 
3. Click the "Edit" button next to "To Override cookie handling for individual 
web sites". 
4. Type in a domain and press the "Allow" button to allow that domain to set 
cookies on your machine. 
5. Press "OK" and close both dialog boxes when done. 
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Top!

Clear The Website Cache Manually In Internet Explorer! 

Internet Explorer 6 normally keeps a cache (a backup copy) of certain parts 
of recently-viewed webpages on your hard disk. This way, if you return to a 
page you just visited within the last few hours or days, Internet Explorer 6 
can first check to see if the webpage has changed since it was cached on 
your hard disk.  
 
If the currently-accessed page has not been changed recently, instead of 
having to load the entire webpage from the Internet, your web browser will 
instead load parts of it from your hard disk. Especially if you are accessing 
the Internet via a dial-up connection this can result in a huge speed increase 
for certain sites. 
 
Situations may crop up, however, where you need to clear this cache. 
Perhaps you are working on a public machine and don't want others viewing 
details about the webpages you visited. Or perhaps Internet Explorer 6 is not 
working quite right; clearing the cache can sometimes solve stability and 
speed problems with the browser. To clear Internet Explorer 6's cache: 
 
1. From Internet Explorer 6, choose "Tools" - "Internet Options". 
 
2. When the "Internet Options" multi-tabbed dialog box appears, click the 
"General" tab. 
 
3. Click the "Delete Files" button. 
 
4. Check "Delete all offline content". 
 
5. Click "OK". 
 
6. Wait (it could take a few seconds or a few minutes) for Internet Explorer 6 
to clear its cache.  
Top!

My Cookies Are Being Deleted In Internet Explorer!  

If you need to keep cookies for a particular website (to store login 
information or preferences), make sure Internet Explorer 6 is configured to 
enable cookies for that particular site. 
 
If you perform this technique and cookies are still not being saved, check 
your firewall and anti-spyware software if you have any installed. Depending 
on your firewall or anti-spyware software settings, all cookies may be deleted 
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before being stored on your computer, or they may only be stored until you 
close the web browser. Techniques for modifying firewall and anti-spyware 
behavior differ depending on the software packages.  
Top!

Try Printing In Landscape Mode In Internet Explorer!  

Often when you try to print web pages, Internet Explore 6 will clip off some 
of the text on the right, making the printed pages only marginally usable. If 
this occurs, try printing your web pages in landscape mode.  
 
Click the "File" menu then "Page Setup". On the dialog box that appears, 
underneath "Orientation", click the "Landscape" radio button. Press "OK" to 
close. 
 
Now, large web pages may not get truncated by IE6 as the landscape 
printing provides for much more horizontal room. 
Top!

Troubleshooting Bad Webpage Printouts In Internet Explorer! 

When you print a webpage using Internet Explorer 6, if the page comes out 
looking odd because some of the background colors and images are omitted, 
there is an easy fix. Click the "Tools" menu and choose "Internet Options". 
On the "Internet Options" multi-tabbed dialog box that follows, select the 
"Advanced" tab. Scroll down through the option until you see "Printing". Now, 
check "Print background colors and images" and press "OK" to close the 
dialog box. 
 
Note that there is a trade-off when doing this; your webpages may print 
slower and you may use more toner or ribbon. Your printouts, however, 
should look much nicer and much closer to what you see in the browser. 
Top!

Always Preview Before Printing In Internet Explorer! 

Before printing a webpage with Internet Explorer 6, always use the Print 
Preview mode to see how the webpage will look on a piece of paper. Just 
click "File" and then "Print Preview" to select this mode. 
 
Why is Print Preview so important? Unfortunately, depending on a webpage's 
layout, graphic elements or blocks of text might get chopped off. Text does 
not always wrap correctly, so you may print out a page of important text only 
to find out huge sections of it missing! That is why you should always Print 
Preview.  
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If you notice missing text or graphics in your on-screen virtual printout, you 
can always change your paper orientation from Portrait to Landscape. Click 
"Close" to exit Print Preview mode. Click "File" then "Page Setup". On the 
"Page Setup" dialog box that follows, choose the "Landscape" radio button 
under "Orientation". Then press "OK" to close that dialog box. Afterwards, 
preview your document again to see if it looks ok and that no text or 
graphics are cut. If everything looks fine, click the "Print" button from the 
Print Preview mode to get a hardcopy of your desired page.  
Top!

Shortcut To Security Properties In Internet Explorer! 

Instead of navigating menus and dialog boxes to get to the Internet Explorer 
6 Security Properties, if your status bar is visible (the bar on the bottom of 
the IE window), find the icon labeled "My Computer", "Internet", "Local 
Intranet", "Trusted Sites", or "Restricted Site" on the right side of the status 
bar. Double-click the icon (or the label) and you will be taken to the Internet 
Security Properties dialog box. 
Top!

Block ActiveX Controls In Internet Explorer!  

ActiveX Controls provide websites with added degrees of functionality, 
interactivity, and multimedia. However, they can also introduce problems, 
such as rogue software masquerading as valid ActiveX Controls that can do 
damage to your computer and/or data. If you want to disable the use of 
ActiveX controls when viewing the Internet, do the following: 
 
1. From IE, choose "Tools" then "Internet Options". 
2. When the "Internet Options" multi-tabbed dialog box appears, select the 
"Security" tab. 
3. Click "Internet". 
4. Click the "Custom Level" button. 
5. When the "Custom Level" dialog box appears, disable all options 
underneath the heading "ActiveX Controls and Plug-ins". 
6. Click "OK" to close the dialog box. 
 
While disabling ActiveX Controls provides a higher level of security, doing so 
may disable Flash and the usage of Windows Update. You can, though, put 
valid sites in a "Trusted Sites" zone. 
 
1. From IE, choose "Tools" then "Internet Options". 
2. When the "Internet Options" multi-tabbed dialog box appears, select the 
"Security" tab. 
3. Click "Trusted Sites". 
4. Click the "Sites" button. 
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5. From here, enter websites as appropriate that you feel are trustworthy. 
Click the "Add" button after adding each site. 
6. Click "OK" to close the dialog boxes.  
Top!

Always Keep Internet Explorer Up-To-Date!  

It's very important that you keep your Internet Explorer browser up-to-date. 
When a new service pack or security patch is released, get it as soon as 
possible! 
 
The importance of this cannot be overstated. Although you may normally 
restrict your browsing to websites that are almost always "safe", there are 
unfortunately those on the Internet that constantly try to come up with ways 
to exploit Internet Explorer security holes to cause damage. These people 
may place rogue code on innocent-looking webpages and try attracting 
people to visit such sites. Do so with an un-patched version of Internet 
Explorer, and who knows what could happen? At best, perhaps your home 
page or search page may get changed without your knowledge. At worst, 
your browser may crash, your entire computer may crash, or your computer 
could get infected with a virus. 
 
To find out what updates are available to your browser, open Internet 
Explorer, choose "Tools", then "Internet Update". Scan for updates and apply 
the latest browser and patch hot-fixes. 
 
Note that if someone else manages your computer hardware and software (if 
you are using a computer at work, for example), be sure to contact your 
administrator before applying fixes. Also, while patches are normally safe to 
install, there is that minimal chance that a patch or hot-fix could cause 
problems to your machine. Always back up your important data before 
applying updates. 
Top!

Keep The Home Page From Changing In Internet Explorer! 

Tired of webpages or software changing your Internet Explorer home page 
from about:blank or your favorite website such as Internet Fixes.Com 
<grin>? There are several ways to help secure Internet Explorer's homepage 
from being changed.  
 
Before performing any of these techniques, be sure to change the home page 
to what you desire, close Internet Explorer, then reopen it to ensure the 
home page is what you set. If the homepage changed again, you may have 
spyware / adware on your machine that must be disabled and/or removed. 
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Once the hompage is set to what you desire, if you are comfortable editing 
the Registry, the following modification will prevent the Home Page in 
Internet Explorer from being changed: 
 
1. Navigate to [[HKEY_CURRENT_USER\Software\ 
Policies\Microsoft\Internet Explorer\] 
2. Create a new DWORD value called Homepage. 
3. Give it a value of 1. 
4. Close the Registry Editor. 
5. Restart Internet Explorer. 
 
Or, you can try the following anti-spyware software that has options to lock 
the Internet Explorer Home Page: 
 
SpywareBlaster: - http://www.javacoolsoftware.com/spywareblaster.html 
 
(instructions current as of v3.2): 
 
1. Click "Tools". 
2. Select the "Misc. IE Settings" tab. 
3. Check "Disable the IE Home Page settings area in the Internet Tools 
Control Panel". 
4. Close SpywareBlaster. 
 
SpyBot Search and Destroy - http://www.spybot.info 
 
(instructions as of v1.3): 
 
1. Select "Mode" - "Advanced". 
2. Click "Tools" in the left pane. 
3. Click "IE tweaks" in the right pane. 
4. Check "Lock IE start page setting against user changes (current user)". 
5. Close SpyBot.  
Top!

Prevent An ActiveX Control From Running In Internet Explorer! 

For security reasons, you may want to prevent certain ActiveX Controls from 
running in Internet Explorer. Perhaps you have a malicious control installed 
that you need to disable that is not currently caught by anti-spyware 
software, or you know of a particular ActiveX control that you never wish to 
download and activate in the first place. To do so, the following Microsoft 
Knowledge Base Article may help: 
 
MSKB 240797 How to Stop an ActiveX Control from Running in Internet 
Explorer - http://support.microsoft.com/kb/q240797/  
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Top!

Just Show The Frequent Favorites In Internet Explorer!  

Do you bookmark a lot of sites with Internet Explorer 6? Your Favorites menu 
probably gets extremely clogged. One way to help organize this menu is to 
have IE only show the most recently used Favorites. Then, if you need them, 
you can click a link to show the rest of the Favorites. 
 
1. Open Internet Explorer 6, choosing "Tools" - "Internet Options". 
2. From the multi-tabbed dialog box that follows, click "Advanced". 
3. Scroll down to "Browsing". 
4. Check "Enable Personalized Favorites Menu". 
5. Press "OK" to close the dialog box. 
 
Now, when you click on the "Favorites" menu, only folders and Favorites you 
have used recently are shown. Click the double-down-arrow to show all your 
favorites. 
Top!

Modify Favorites With The Explorer Interface! 

Tired of using the default Internet Explorer 6 mechanisms to modify your 
Favorites? If you are a Windows "power user", you may find modifying your 
Favorites with Explorer easier.  
 
1. From the "Start" button, choose "Run". 
2. Type "Favorites" (without the quotes) and press ENTER. 
(Note that this works under Windows XP and may not work on earlier 
versions of Windows). 
 
From here it is easy to do the following, and more: 
 
1. Create a folder (right-click in the window, choose "New" then "Folder" and 
give it a name). 
2. Rename a Favorite or folder (click on a Favorite or folder, press F2, then 
edit). 
3. Move a Favorite between folders (just drag-and-drop the Favorite). 
4. Delete a Favorite or folder (right-click a Favorite or folder, select Delete). 
5. Change a Favorite's URL (right-click a Favorite, choose "Properties", 
change the URL). 
Top!

Delete A Favorite In Internet Explorer! 
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To remove one of your Favorites from Internet Explorer 6 without going 
through the "Organize Favorites" dialog box: 
 
1. Open the "Favorites" menu.  
2. Navigate to and highlight the Favorite you want to delete.  
3. Right-click, then choose "Delete" from the popup menu that appears.  
4. Depending on your Windows settings, you may be asked to confirm 
moving the Favorite to your Recycle Bin. Say "Yes", and it is gone! 
Top!

Print A Favorite Without Visiting the Page!  

You can print the webpage of one of your Internet Explorer 6 Favorites 
without viewing the site in the browser window. To do so:  
 
1. Open the "Favorites" menu.  
2. Navigate to and highlight the Favorite representing the webpage you wish 
to print.  
3. Right-click on the Favorite and choose "Print" from the popup menu that 
appears.  
4. Follow the onscreen dialog boxes, and then watch your webpage print 
without you having to view it in your browser!  
Top!

Create A Favorite Shortcut On Your Desktop!  

While the Internet Explorer 6 Favorites menu lets you quickly access sites 
you wish to visit again, perhaps you find the task of opening Internet 
Explorer 6, accessing the Favorites menu, then finding and clicking the site 
cumbersome? If you have a Favorite that you visit daily and would like a 
quick shortcut to it from your Desktop, do the following: 
 
1. Open Internet Explorer 6. Do not maximize the window. If it is already 
maximized, shrink the window size so you can see the Desktop. 
2. Open the "Favorites" menu. 
3. Navigate to and highlight the Favorite representing the webpage you wish 
to print. 
4. Hold the right mouse button down on the Favorite, then drag to the 
Desktop and release the right mouse button. 
 
Voila! A shortcut to your Favorite is now a double (or single, depending on 
your Windows settings) click away on your Desktop!  
Top!

Quickly Rename A Favorite In Internet Explorer! 
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Would you like to rename the description of one of your Internet Explorer 6 
Favorites without navigating the "Organize Favorites" dialog box? 
 
1. Open the "Favorites" menu.  
2. Navigate to and highlight the Favorite you want to delete.  
3. Right-click, then choose "Rename" from the popup menu that appears. 
4. Type in your new Favorite name and press "OK". 
 
The change should be reflected in your Favorites menu. 
Top!
 
Sort Your Favorites In Internet Explorer! 
 
After you add dozens (hundreds?) of websites to your Internet Explorer 6 
Favorites menu, it may be hard to find what you are looking for, especially if 
you do not organize your Favorites into subfolders. Use this tip to make your 
task a little easier by sorting your Favorites by name. 
 
1. Open the "Favorites" menu from Internet Explorer 6. 
2. Right-click on any Favorites and when the popup menu appears, choose 
"Sort By Name". 
Top!

Disable Add-On Toolbars And Buttons In Internet Explorer! 

If you surf the web often, you may have come across various extensions to 
your web browser such as toolbars, extra link buttons, etc. Or, perhaps you 
have new buttons and toolbars on Internet Explorer 6 appear without 
warning and would like to remove them. 
 
If you want to quickly remove these add-ons to your browser without having 
to go through the "Add/Remove Programs" routine, just click the "Tools" 
menu and choose "Internet Options". Click the "Advanced" tab on the multi-
tabbed dialog box that follows. Scroll down underneath "Browsing" until you 
find the checkbox "Enable third-party browser extensions". Uncheck this box 
and press "OK" to close the dialog box.  
 
Finally, close all Internet Explorer browsers and restart them. Voila! The 
extra toolbars and buttons should now be gone. 
 
If the toolbars reappear, you most likely have spyware on your machine and 
need to get rid of it. Visit the Internet Fixes Forum page and post a question 
for more information on ridding yourself of these pests. 
http://internetfixes1.brinkster.net/forum/default.asp 
Top!
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